


THE FREEDOM

will change your life

Safety Tubs®, the world leader in acrylic walk-in bathtubs,
makes it easy to get in and out of the tub and enjoy the
comfort of bathing. Everything about a Safety Tub®

is designed to give you the freedom to bathe — on your
own - in safety, comfort and convenience. Simply walk-in,
close the door and relax with a warm soak or a swirling
whirlpool massage.

PEACE OF MIND

comes from safe bathing

If safe and easy bathing is a concern to you and your

loved ones, a Safety Tub® is perfect for you. Safety Tubs®
accessible design allows everyone in the family - including
those experiencing age and mobility challenges - to enjoy
safe, luxurious soaks and massages. The low entry, built-in
safety bar and slip-resistant tub floor are just a few features
that make bathing safe with a Safety Tub®.

THE COMFORT

alleviates aches and pains

Safety Tubs® are great for arthritis, rheumatism, back pain
and other common aches and pains. You will notice a
difference in how you feel after just one warm, deep soak
or therapeutic massage. Used regularly, the Safety Tub®
will literally transform your life.

SAFETY TUBS'
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Model: ST6032.177 DEEP, SPACIOUS,

Acrylic Safety Tub®

Size: 60" long x 32" wide x 37" high A N D LU X U R I 0 U S

Operating Capacity: 80 gallons . . .
premium acrylic walk-in tub

Colors

White and Biscuit

Included
« Patented T5™ Door System Technology

« Color matched drain and overflow
 Color matched safety bar
« Slip-resistant tub floor

Whirlpool Options

Jet Massage System

» Premium adjustable jet system

» Deluxe back massage

» Legs only massage

« Self-cleaning Sanitary System — Ozone
Air Bubble Massage System 18"
« Variable speed controls

« Five Star air bubble system
» Quiet variable speed heated blower

Dual Massage System

» Premium adjustable jet system

» Deluxe back massage

+ Legs only massage

Five Star air bubble system

Quiet variable speed heated blower
Neck pillow

Self-cleaning Sanitary System — Ozone
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60"
Front View

Notes 16"
« Also available as soaking tub é
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Other Options
» Minute Drain™ fast water removal system

* In-line heater for jet and dual systems )
» Chromatherapy - multicolored bath lights []
= Aromatherapy - fragrance system 50"

» Neck pillow (included with dual massage) Top View
» Premium faucet with personal shower

» Decorative grab bar with handshower glide

« Anti-scalding valve

« Left hand or right hand door

« Tile or Flat Wall Surround System

28 1/2" 17" —







Model: ST6032 ROOMY AND

Acrylic Safety Tub®

Size: 60" long x 32" wide x 32" high CO M F O RTA B L E

Operating Capacity: 70 gallons . ) )
premium acrylic walk-in tub

Colors

White and Biscuit

Included

» Patented T5™ Door System Technology
« Color matched drain and overflow

« Color matched safety bar

« Slip-resistant tub floor

Whirlpool Options

Jet Massage System

» Premium adjustable jet system

» Deluxe back massage

 Legs only massage

« Self-cleaning Sanitary System — Ozone
Air Bubble Massage System 18"
« Variable speed controls

- Five Star air bubble system
» Quiet variable speed heated blower

Dual Massage System

» Premium adjustable jet system

» Deluxe back massage

 Legs only massage

- Five Star air bubble system

» Quiet variable speed heated blower

» Neck pillow

« Self-cleaning Sanitary System — Ozone

N—

60"
Front View

Notes 16"
« Also available as soaking tub é
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Other Options
» Minute Drain™ fast water removal system

* In-line heater for jet and dual systems Q
» Chromatherapy - multicolored bath lights |

» Aromatherapy - fragrance system 60"

» Neck pillow (included with dual massage) Top View

» Premium faucet with personal shower

» Decorative grab bar with handshower glide

« Anti-scalding valve

« Left hand or right hand door

« Tile or Flat Wall Surround System

31" 15" —=
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Model: ST5130 PRACTICAL

Acrylic Safety Tub®
Size: 51”long x 30" wide x 37" high A N D M I D'S I Z E D

Operating Capacity: 60 gallons . . .
premium acrylic walk-in tub

Colors
White and Biscuit

Included
« Patented T5™ Door System Technology

« Color matched drain and overflow
 Color matched safety bar
« Slip-resistant tub floor

Whirlpool Options

Jet Massage System

» Premium adjustable jet system

* Deluxe back massage

+ Legs only massage

« Self-cleaning Sanitary System — Ozone
Air Bubble Massage System 16 1/4"

« Variable speed controls r ;
« Five Star air bubble system

» Quiet variable speed heated blower

Dual Massage System

» Premium adjustable jet system

» Deluxe back massage

+ Legs only massage

Five Star air bubble system

Quiet variable speed heated blower

37.1/2"

» Neck pillow 51"
« Self-cleaning Sanitary System — Ozone Front View
Notes ;
« Also available as soaking tub 15" S |
. 24 i
Other Options L~ Hot =
» Minute Drain™ fast water removal system . 16"
* In-line heater for jet and dual systems
» Chromatherapy - multicolored bath lights T

» Aromatherapy - fragrance system

» Neck pillow (included with dual massage)

» Premium faucet with personal shower

» Decorative grab bar with handshower glide
« Anti-scalding valve

« Left hand or right hand door

» Extension Kit to fit 60" opening

» End Panel

« Tile or Flat Wall Surround System

51"
Top View
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Model: ST5126

Acrylic Safety Tub®

Size: 51”long x 26” wide x 37" high
Operating Capacity: 45 gallons

Colors
White and Biscuit

Included
« Patented T5™ Door System Technology

» Color matched drain and overflow
» Color matched safety bar
« Slip-resistant tub floor

Whirlpool Options

Jet Massage System

» Premium adjustable jet system

» Deluxe back massage

» Legs only massage

« Self-cleaning Sanitary System — Ozone

Air Bubble Massage System

« Variable speed controls

« Five Star air bubble system

» Quiet variable speed heated blower

Dual Massage System

« Premium adjustable jet system

» Deluxe back massage

» Legs only massage

« Five Star air bubble system

* Quiet variable speed heated blower

= Neck pillow

« Self-cleaning Sanitary System — Ozone

Notes
« Also available as soaking tub

Other Options

» Minute Drain™ fast water removal system
« In-line heater for jet and dual systems

« Chromatherapy - multicolored bath lights
» Aromatherapy - fragrance system

= Neck pillow (included with dual massage)
» Premium faucet with personal shower

« Decorative grab bar with handshower glide
» Anti-scalding valve

« Left hand or right hand door

» Extension Kit to fit 60" opening

» End Panel

« Tile or Flat Wall Surround System

SPACE
FRIENDLY

premium acrylic walk-

in tub
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Model: ST4828 VERSATILE

Acrylic Safety Tub®
Size: 48" long x 28" wide x 38" high A N D CO M PACT

Operating Capacity: 45 gallons X i .
premium acrylic walk-in tub

Colors
White

Included
» Patented T5™ Door System Technology

« Color matched drain and overflow
 Color matched safety bar
« Slip-resistant tub floor

Whirlpool Options

Jet Massage System

» Premium adjustable jet system
 Deluxe back massage

» Legs only massage

« Self-cleaning Sanitary System — Ozone
Air Bubble Massage System 16 1/4"

« Variable speed controls r :
« Five Star air bubble system

» Quiet variable speed heated blower

Dual Massage System

» Premium adjustable jet system

» Deluxe back massage

 Legs only massage

Five Star air bubble system

Quiet variable speed heated blower

37.1/2"

» Neck pillow 48"
« Self-cleaning Sanitary System — Ozone Front View
Notes i
« Also available as soaking tub 140 D |
) 21 1/2" i
Other Options L~ Hot &
» Minute Drain™ fast water removal system o 15"
* In-line heater for jet and dual systems
» Chromatherapy - multicolored bath lights T
» Aromatherapy - fragrance system =
» Neck pillow (included with dual massage) e e

» Premium faucet with personal shower

» Decorative grab bar with handshower glide
« Anti-scalding valve

« Left hand or right hand door

« Extension Kit to fit 60" opening

» End Panel

« Tile or Flat Wall Surround System
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Model: S56030 DEEP, ROOMY

Gelcoat Safety Tub®
Size: 60" long x 30" wide x 37" high A N D CO M F O RTA B L E

Operating Capacity: 75 gallons .
gelcoat walk-in tub

Colors
White and Biscuit

Included
» Color matched drain and overflow

 Color matched safety bar
« Slip-resistant tub floor

Whirlpool Options

Jet Massage System

» Premium adjustable jet system

» Deluxe back massage

+ Legs only massage

« Self-cleaning Sanitary System — Ozone

Air Bubble Massage System
» Variable speed controls 18"

« Five Star air bubble system % =5

« Quiet variable speed heated blower 16"

Dual Massage System )

» Premium adjustable jet system Co &
» Deluxe back massage 7 &
+ Legs only massage

« Five Star air bubble system —

» Quiet variable speed heated blower

» Neck pillow 60"

« Self-cleaning Sanitary System — Ozone Front View

Notes |
« Also available as soaking tub i ﬁ
Other Options é _

« Minute Drain™ fast water removal system =¥ " 3
* In-line heater for jet and dual systems 28" 15" —=—|

» Chromatherapy - multicolored bath lights i/

» Aromatherapy - fragrance system |
» Neck pillow (included with dual massage) po

» Premium faucet with personal shower Top View

» Decorative grab bar with handshower glide
« Anti-scalding valve

« Left hand or right hand door

« Tile or Flat Wall Surround System
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Model: $55430 PRACTICAL

Gelcoat Safety Tub®
Size: 54" long x 30" wide x 38" high* A N D M I D - S I Z E D

Operating Capacity: 65 gallons .
gelcoat walk-in tub

Colors
White and Biscuit

Included
» Color matched drain and overflow

 Color matched safety bar
« Slip-resistant tub floor

Whirlpool Options

Jet Massage System

» Premium adjustable jet system

* Deluxe back massage

+ Legs only massage

« Self-cleaning Sanitary System — Ozone
Air Bubble Massage System

» Variable speed controls 18"
« Five Star air bubble system

» Quiet variable speed heated blower

Dual Massage System

» Premium adjustable jet system

» Deluxe back massage

+ Legs only massage

« Five Star air bubble system

» Quiet variable speed heated blower

» Neck pillow

« Self-cleaning Sanitary System — Ozone

54"

Notes Front View
« Also available as soaking tub )

\
Other Options 14 30 |
» Minute Drain™ fast water removal system é 23"
* In-line heater for jet and dual systems 10"
» Chromatherapy - multicolored bath lights 25 1/2" 15"
» Aromatherapy - fragrance system p/—\DJ I
» Neck pillow (included with dual massage) [ '
» Premium faucet with personal shower 54
» Decorative grab bar with handshower glide Top View

« Anti-scalding valve

« Left hand or right hand door

» Extension Kit to fit 60" opening

« Tile or Flat Wall Surround System
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Model: SS5230

Gelcoat Safety Tub ©

Size: 52" long x 30" wide x 42" high*
Operating Capacity: 60 gallons

Colors
White and Biscuit

Included
» Color matched drain and overflow

 Color matched safety bar
« Slip-resistant tub floor

Whirlpool Options

Jet Massage System

» Premium adjustable jet system

» Deluxe back massage

+ Legs only massage

« Self-cleaning Sanitary System — Ozone

Air Bubble Massage System

» Variable speed controls

« Five Star air bubble system

» Quiet variable speed heated blower

Dual Massage System

» Premium adjustable jet system

» Deluxe back massage

+ Legs only massage

« Five Star air bubble system

Quiet variable speed heated blower
Neck pillow

Self-cleaning Sanitary System — Ozone

Notes
« Also available as soaking tub

Other Options
» Minute Drain™ fast water removal system

* In-line heater for jet and dual systems

» Chromatherapy - multicolored bath lights

» Aromatherapy - fragrance system

» Neck pillow (included with dual massage)

» Premium faucet with personal shower

» Decorative grab bar with handshower glide
« Anti-scalding valve

« Left hand or right hand door

» Extension Kit to fit 60" opening

« Tile or Flat Wall Surround System

EXTRA DEEP
AND INNOVATIVE

gelcoat walk-in tub

421/2"

52"
Front View

52"
Top View
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Model: $54828 VERSATILE

Gelcoat Safety Tub®

Size: 48" long x 28" wide x 38" high* A N D CO M PACT

Operating Capacity: 45 gallons .
gelcoat walk-in tub

Colors
White and Biscuit

Included
» Color matched drain and overflow

 Color matched safety bar
« Slip-resistant tub floor

Whirlpool Options

Jet Massage System

» Premium adjustable jet system

» Deluxe back massage

+ Legs only massage

« Self-cleaning Sanitary System — Ozone

Air Bubble Massage System

» Variable speed controls 15"
« Five Star air bubble system m
» Quiet variable speed heated blower ) ] 1'!
Dual Massage System 16 1/2"
» Premium adjustable jet system ' "
» Deluxe back massage T ' N
» Legs only massage m
« Five Star air bubble system 17"
» Quiet variable speed heated blower ) ¥
» Neck pillow :
« Self-cleaning Sanitary System — Ozone

47172
Notes Front View
« Also available as soaking tub .

\

Other Options 14"
+ Minute Drain™ fast water removal system é 22" i
* In-line heater for jet and dual systems = :
» Chromatherapy - multicolored bath lights 22" 15"
» Aromatherapy - fragrance system P/_\LJ [
» Neck pillow (included with dual massage) [ '
» Premium faucet with personal shower 47 172"
» Decorative grab bar with handshower glide Top View

« Anti-scalding valve

« Left hand or right hand door

» Extension Kit to fit 60" opening

« Tile or Flat Wall Surround System




ADOITONHO4L.S1




Revolutionary T5™ Door Frame

Provides strength and durability

» Maintains tub strength with moisture
changes in the bathroom

 Provides a completely flat surface for
a watertight seal

« Integral hinge channel for absolute
door alignment

» Dedicated seal track allows for easy
field replacement

« Non-corrosive, color-matched

« Aluminum construction

Santoprene® T5™ WatertightDoor Seal
Guaranteed not to leak, for life
« Highly durable material maintains

shape for years of trouble free use

« Specially engineered bulb and base
ensures watertight performance

« Resistant to UV, fatigue, water,
acids, oils and lubricants

» Easy to clean

Robust T5™ Door Hinge

Proper functionality, always

» Premium grade aluminum for
strength and durability

« Stainless steel stake pin for longevity

» Non-corrosive color-matched finish

» Engineered for smooth operation

Soft Touch™ T5™ Door Handle System
Effortless and easy-to-use
» Remarkably engineered for watertight seal

« Stainless steel sloped strike plate insures
secure closure

» Ergonomically styled handle for comfort
and ease of operation

« Specially designed for minimal closing effort

Elegantly Styled T5™ Finishing Caps

Beautiful attention to detail

» Provides closure to top of door seal to
eliminate water penetration

» Non-corrosive color-matched aluminum

« Provides finish detail to the T5™ door system

PATENTED T5™
DOOR SYSTEM

advanced technology




WHIRLPOOL OPTIONS

turn your bath into a health spa

Once used only in health spas, warm whirlpool bath therapy is now a common and
effective treatment for symptoms of arthritis, back pain and other common ailments.
While soaking in warm water alone increases circulation and helps realize the relief
of certain types of pain, the addition of the Premium Jet Massage and Five Star Air
Bubble Massage systems increases the overall health benefits of a warm bath.

THE LATEST TECHNOLOGY

for a complete bathing experience

Jet Massage System™
The water will revive you

Tailor the effects of your whirlpool experience with the
Deluxe Back Massage and Legs Only Massage systems to
achieve a new level of comfort and results. The Legs Only
Massage allows you to direct the flow of water solely to

the well area of the tub to carefully massage your lower
extremities. This feature enables you to fill the bottom half

of the tub only for a quick leg bath. The Deluxe Back Massage
consists of multiple, strategically positioned jets for the most
comfortable and therapeutic lower back massage available.
Includes the self-cleaning sanitary system - Ozone.

Air Bubble Massage System™

Soothing your body and mind

The Five Star Air Bubble System sends thousands of air
bubbles bouncing throughout the tub to create a soft,
full-body champagne bath. Unlike most air systems,
the Safety Tubs® Five Star Air Bubble System forces
bubbles farther and deeper into the bathing area for
the most complete, gentle massage. You'll find yourself
relaxing fully as you enjoy the sensation of a caressing
skin massage.
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Dual Massage System™
The ultimate body therapy

Perhaps you'll prefer the light, soft bubbles of the Five Star
Air Bubble System bath one day, and the invigorating
hydrotherapy of the Premium Jet Massage System the next,
or want to experience both at once. With the Dual Massage
System, you can set the mood with a touch of a button

by selecting either or both at once for the ultimate bathing
experience. Includes air-filled neck pillow and self-cleaning
sanitary system - Ozone.




Chromatherapy
Healing with color and light

Chromatherapy is the use of color and light that has been
determined to have a positive effect on both health and
mental well-being. Safety Tubs® Chromatherapy options
features multicolored LED lights positioned in the basin
of the tub that illuminate the water and enhance your
bathing experience.

Aromatherapy
Enjoy the mood

Combine hydrotherapy and aromatherapy for the
ultimate in relaxation. Positioned on the deck of the tub,
the aromatherapy system automatically distributes your
choice of fragrances throughout your Safety Tub® while
running the jet or air bubble massage systems. The starter
kit contains four fragrances which can be replenished

at local department stores.

Self-Cleaning Sanitary System (Ozone)
Eliminate the maintenance

Say “goodbye” to the maintenance needed to enjoy

a clean whirlpool system. Included with jet and dual
massage systems, Ozone is the most effective cleaning
system available for bathing environments today.
Approved by the NSF, FDA and EPA and required in

all commercial bathing environments, this safe and
effective sanitation system automatically oxidizes and
eliminates disease-causing microorganisms in the tub
when the whirlpool system is activated.

In-line Water Heater

Maintain your water temperature

No need to continuously add warm water to your bath.
Designed for the jet and dual massage systems, the
in-line heater from Safety Tubs® is automatically activated
to maintain the water temperature longer so you can
relax and enjoy the ultimate bathing experience.
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Model: STEXTKIT
ForST5130,ST5126
and ST4828 Safety Tubs®

Colors
White and Biscuit

Custom Fit Extension Kit

» Converts 51”and 48" tubs to fit
into standard 60" spaces

« Left hand or right hand installation

» Acrylic construction

« Works with 51”x 26" 51" x 30"
and 48" x 28" acrylic tub models:
soakers, jet massage, air massage
and dual massage

« Easy assembly
* Perfect fit

Model: SSEXTKIT
For Gelcoat S55430, 55230
and 554828 Safety Tubs®

Colors
White and Biscuit

Custom Fit Extension Kit
« Converts 54" 52" and 48" tubs
to fit in standard 60" spaces
« Left hand or right hand installation
» Gelcoat construction
« Works with 54" x 30" 52" x 30"
and 48" x 28" gelcoat tub models:
soakers, jet massage, air massage
and dual massage

 Easy assembly
* Perfect fit

THE EXTENSION KIT
FOR A PERFECT FIT

...every time
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Fast Draining, No Waiting

The Minute Drain™ is a powered pump that
evacuates water from our walk-in tubs faster
than typical drains, which means you spend
less time waiting. With Safety Tubs® Minute
Drain™, you can walk out of the tub when
you are ready.

Eight Times Faster

Designed to work independently or together
with the manual waste and overflow assem-
bly, the Minute Drain™ is up to 8 times faster
than conventional draining systems. And
since this system ties into the manual waste
and overflow and plugs directly into the wall
(in the same way as the whirlpool pump),
there is no additional plumbing required.

The Minute Drain™ is equipped with a pump,
safety suction and on/off electronic control
which allows you to activate the system with
a touch of a button to quickly and completely
drain your Safety Tub®.

Breakthrough Technology

Designed by our team of world class engineers,
Safety Tubs® continues to revolutionize the
industry with the introduction of this patent
pending design that significantly enhances
the walk-in tub bathing experience.

MINUTE DRAIN™ FAST
WATER REMOVAL SY

...walk out when you’re ready
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REVOLUTIONARY PATENTED DOOR SYSTEM

for safe, easy access

Safety Tubs® patented T5™ door system eliminates the need to step over the
front of the tub and allows safe and effortless entry. Simply walk in, close the
door and relax! No straining to get in or out of the tub.

WATERTIGHT DOOR SEAL

with a lifetime guarantee

Best of all, the T5™ door system will not warp, rust or leak. The watertight
seal is guaranteed for life. It's an ingenious solution that doesn’t need
special care or maintenance.

PREMIUM BATH CONSTRUCTION

the best bathing materials

Safety Tubs® offers Acrylic walk-in bathtub construction with a free standing
metal support frame, a first for walk-in bathtubs that offer 17” chair height
seats. This is the material of choice for leading bathtub manufacturers and
trade professionals across the country. Germ and stain resistant surfaces,
better heat retaining properties and durability are just a few of the many
benefits of acrylic.

SHOWER IN YOUR SAFETY TUB®

wall mounted or hand-held

Safety Tubs® optional faucet with hand-held shower allows you to convert
your bathtub into an easy-to-use and attractive shower. Use it standing up
or sitting down for peace of mind and security while bathing.

17” CHAIR HEIGHT BUILT-IN SEAT

for easy up and down

The built-in, contoured, chair height seat means you won't find yourself
struggling to get up or down. Safety Tubs® are nearly twice as deep as
regular bathtubs so you'll enjoy much more room to soak. Submerge
yourself and enjoy a luxurious bathing experience.

BUILT-IN SAFETY BAR & SLIP RESISTANT FLOOR

for safety and convenience

The built-in safety bar and slip-resistant tub floor adds even more
security and further increases your peace of mind. Every detail about
the Safety Tub® is designed for your independence, safety, comfort
and convenience.

NEW HANDLE

ergonomic design for easy use

Safety Tubs® ergonomically designed T5™ door handle allows for you
to easily open and close the door regardless of your physical strength
or condition. This unique handle system including the stainless steel
sloped strikeplate provides full leverage and insures secure closure.




TUB CONFIGURATION:

Patented T5™ door system
with ergonomic handle
Chair height contoured seat
Hand-held shower

Built-in safety bar
Faucet/motor access panels
Hydro massage jets

Air bubble massage jets
Color matched waste and overflow
Slip-resistant floor
Whirlpool & light controls
Aromatherapy basin

Ozone jet

Minute Drain™

Minute Drain Control
Chromotherapy light
Deluxe back jets

Neck pillow

SIZES: L xwxH)

Acrylic: Gelcoat:
60"x32"x 37" 60"x30"x 37"
60"x32"x 32" 54"x 30" x 38"
51"x30"x 37" 52"x30"x 42"
51"x26"x 37" 48" x 28"x 38"
48"x 28"x 38"

STYLES:

Soaker (Tub Only)

Jet Massage System™
Air Bubble Massage System™
Dual Massage System™

STRUCTURE:

Metal support frame






